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Notices 
Information provided in this manual is a result of the design and development of Axcess 
International, Inc.. products and is subject to change without notice. It applies only to 
current Axcess International, Inc.. systems. 

No part of this manual may be reproduced, translated or transmitted, in any form or by 
any means, without the prior written consent of Axcess International, Inc.. 

Responsibilities 
·  Axcess International, Inc.. declines all liability for any damage that might result from 

any errors or omissions in this document or from improper installation. 

·  Axcess International, Inc.. can only guarantee the correct operation of its products if 
they are used with the software programs, systems, and consumables supplied or 
authorized in writing by Axcess International, Inc.. 

·  Axcess International, Inc.. recommends keeping the original packaging for 
transporting the equipment later. 

Registered Trademarks 
Product names mentioned herein may be trademarks and/or registered trademarks of 
their respective companies. 

Customer Service 
Axcess International, Inc.. toll-free support line is1-800-577-6080.  
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Installation 

System Requirements 
Before installing AxcessView, make sure you have the following system requirements: 

Hardware 
·  PC mother board with 1 GHZ CPU (Intel Pentium III preferred) 
·  256 MB DRAM 
·  4 MB video RAM 
·  1 - serial port 
·  1 - parallel port  
·  High speed EIDE disk controller interface 
·  1.44 floppy drive 
·  CD ROM drive 
·  20 GB EIDE hard disk drive 
·  PS-2 mouse 
·  Keyboard 
·  17 inch monitor 
·  10/100 Ethernet card 
 

Software 
·  Windows 2000 Professional 
·  Access 2000 ODBC drivers 
·  Crystal Reports Run Time 
·  AxcessView Software 

 

Network Receiver 
·  V1.4 or higher 
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Installing AxcessView  
There are two scenarios for installing AxcessView, First Time Installation and Updating 
a Previous Version of AxcessView. 

First Time Installation 
 

1. Insert the AxcessView CD into your CD-ROM drive. 

2. If you have a Plug and Play CD-ROM, an installation wizard displays. 

3. Otherwise, select Run from the Start menu. 

4. Type D:\Setup.exe (where D = your CD-ROM drive) and press ENTER or click OK. 

5. Follow the prompts in the InstallShield Wizard.  

6. Click Finish to complete the installation. 

 

The installation wizard creates an AxcessView icon on the desktop.  To start 
AxcessView, double-click the icon. 

Updating Previous Versions 
 

To avoid loss of data, we strongly 
recommend making a back up copy of your 
Access database before you upgrade 
AxcessView. 

 

Making a Backup Copy of AxcessView Database 
 

1. Using Microsoft Explorer, locate the database file containing the information on 
Assets and Personnel.  The file has a file extension of .mdb.  For example, the name 
of the file could be MyData.mdb (Note: Axcess2000.mdb is the default). 

The file may be located in your AxcessView folder in the Program Files folder of your 
c: drive. 

C:\Program Files\AxcessView 

C:\Program Files\Axcess International, Inc.\AxcessView 

2. Right-click the file and select Copy from the pop-up menu. 

3. Select another folder to which to copy the file temporarily. Open that folder and click 
Paste from the Edit menu.  You should see a copy of your database file in this folder.  

4. After you complete the AxcessView upgrade, locate the database file you just pasted 
into a temporary folder. 

5. Right-click the file, and click Copy from the pop-up menu. 

6. Open the AxcessView folder and click Paste from the Edit menu. All data originally 
stored in this file is now accessible in the new version of AxcessView. 
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AxcessView Basics 
AxcessView displays information received from the ActiveTag RFID system. Pictures of 
personnel and assets are displayed along with information about where the Tags were 
read. 

AxcessView also can display alarms when a tagged asset is discovered without its 
owner.  

AxcessView supports a two-tier security system, consisting of Operators and 
Administrators. 

·  Administrator – can modify all aspects of the database. 

·  Operator – can only view data and confirm alarms.  

Starting AxcessView 
It is recommended that the first person to launch AxcessView should be the 
Administrator. 

1: Double-click AxcessView.exe. or click the AxcessView icon on the desktop.  

2: Select Open Database from the File menu. The Administrator Logon (First Time) 
dialog box will appear (Figure 1). 

 

Figure 1 Administrator First Time Logon 

3: Choose a password for the Administrator. Type the password in the Password box 
and retype it in the Confirm Password box. Click OK. 

IMPORTANT!  Do NOT lose your password. It is highly recommend that the 
password be written down and put in a safe location. You will not be able to retrieve 
the password should you forget it. You must call AXCESS Customer Support for 
assistance. 

4: A dialog box appears indicating that it will take a few seconds to prepare the main 
database. Click OK. 

5: Select Administrator from the User menu. Type your name and the Administrator 
password.  Click Logon. 

 
To Change the Administrator Password 
You must logged on as an Administrator in order to change the Administrator password. 

����
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1: Select Change Password from the Users menu located at the top of the AxcessView 
window. The Administrator Password dialog box will appear.  

2: Type in the old password. 

3: Type in a new password.  

4: Retype the new password to confirm and click OK. 

Logging On 
If you are not login as the Administrator, the choices of the drop-down menus Manage 
Asset List and the Manage Personnel List will not be grayed out. 

1: Select your user type – Administrator or Operator – from the User menu.  

2: For the Administrator account, enter your name and the Administrator password.  

3: For an Operator account, enter your Operator Name and an ID.  

Saving Data 
AxcessView saves information automatically. It is not necessary to manually save 
information. 

Tool Tips 
When the cursor rests over an icon or menu selection, information about the item 
displays in the status bar located at the bottom of the window. 

Exiting  
To exit AxcessView, click Exit from the File menu or click the Close button in the upper 
right corner of the screen. It is not necessary to disconnect from each remote device 
before exiting. 

 
 
Close button 
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Setting up the Database 
This chapter explains how to enter personnel and asset data, configure zones and 
configure AxcessView. 

IMPORTANT!  In order to modify the database, you must be logged on as the 
Administrator. 

Personnel Information 
Specific personnel information must be entered into the AxcessView database. Such 
information includes tag ID number, first and last name, and assets that may be linked to 
that individual.  

Select Manage Personnel List from the File menu. The Personnel Dialog box will appear 
(Figure 2).  

 

Figure 2 Employees dialog box 

Adding Personnel Information 

1: Click Add. The Add Personnel dialog box appears (Figure 3). 

����
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Figure 3 Adding personnel information 

 

2: Type the person’s name in the provided First Name and Last Name boxes. If the 
name has already been entered, AxcessView notifies you that this is a duplicate.  

3: Type the tag ID number in the Tag ID box. 

NOTE  The tag ID is an eight-digit number is comprised of the 3-digit Facility Code 
and the 5-digit tag ID number. Only the leading zeros may be omitted. 

4: Select the Normal or Beacon tag type from the Tag Type drop-down list. 

Normal – this tag remains inactive until it passes an antenna generating a specific 
RF activation field at which time it transmits a message 

Beacon – this tag transmits a message at specific intervals, regardless of whether it 
pass through a RF field or not. 

NOTE  Refer to the Tag Types section of this manual for more information. 

5: To display an image when the Tag is read, enter a path to the JPEG or bitmap file or 
click Browse. The Browse dialog box will appear. 

6: Select a the file and click Open.  

NOTE  Images must be in either bitmap or JPEG file format only. 

7: Click OK. The new person is listed in the Personnel Dialog table. 

8: Click Close to finish. 

 

TIP  The information in the Personnel Dialog box can be sorted by clicking on the column 
headings. 
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Editing Personnel Information 

1: Select the person’s name and click Edit.  The Edit Personnel dialog box will appear 
(Figure 4). 

 

Figure 4 Editing personnel information 

 

2: Modify the information displayed. 

3: Click OK. The changes are reflected in the table. 

4: Click Close to finish. 

Deleting Personnel Information 

1: Select the person’s name and click Delete. You will receive a warning box.  

NOTE  If an asset is linked to that person, the asset must be deleted first. 

2: Click Yes to delete the entry or No to cancel. 

3: Click Close to finish. 

Asset Information 
Similar to adding personnel, adding assets requires specific information to be entered 
into the AxcessView database. This includes the tag ID, description, make and model, 
serial number, and the personnel who are linked. 

Select Manage Asset List from the File menu. The Assets List dialog box will appear 
(Figure 5). 
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Figure 5 Asset dialog box 

TIP  The information can be sorted by clicking on each column heading. 
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Adding Asset Information 

1: Click Add. The Add Asset dialog box will appear (Figure 6).  

Figure 6 Adding an asset 

2: Enter the tag ID number. (Refer to the Personnel Information section of this manual 
for more information.) 

The following information is optional: Description, Make, Model, and Serial Number.  

3: Select Normal or Beacon tag type from the Tag Type drop-down list. 

NOTE  Refer to the Tag Types section of this manual for more information. 

4: Select the Generate Warning check box to send an alarm when the asset is detected 
without its assigned owner, or without any owner.  

5: To display an image when a Tag is read, enter the path to the asset’s picture or click 
Browse to locate the bitmap file. 

NOTE  Images must be in either bitmap or JPEG file format only. 

6: Click OK. The new asset is listed in the table. 

7: Click Close to finish. 

Assigning an Owner 
By linking an asset to an employee, the proper owner or custodian of the asset is 
established. This enables AxcessView to determine if an asset has been moved without 
its proper custodian. 

1: Select the asset you want to assign in the top table. 
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2: Select a name from the Personnel List. This list includes all Personnel database 
entries. Double-click a name to get information about that person. 

3: Click <<Add. The selected name will appear in the Owner(s) list.  

4: If the asset has more than one owner, repeat the above steps. Select the name and 
select the Primary Owner check box to indicate the primary owner of the asset (e.g. 
posses it most of the time, etc.). 

Removing an Owner 

1: Select the asset from which you want to remove the owner. 

2: Select the custodian’s name in the Owner(s) list.  

3: Click Delete>> The person’s name will be removed from the Owner(s) list. 

Editing Asset Information 

4: Select the asset you want to change. 

5: Click Edit. The Edit Asset dialog box will appear (Figure 7). 

 

 Figure 7 Editing asset information 

1: Make changes to the information. 

2: Click OK. The changes are reflected in the table.  

3: Click Close to finish. 

Deleting Asset Information 

4: From the Asset List dialog box, select the asset you want to remove from the list. 
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5: Click the Delete button at the top left of the Asset List screen. 

6: You will receive a message asking, “Do you really want to delete item?” 

Click Yes to delete the asset information or click No to cancel. 

7: Click Close to finish. 

Device Information 
Before zones can be created, remote device information must be entered into the 
AxcessView database. 

From the Configure menu, select System Configuration. The Device-Zone Setup dialog 
box will appear (Figure 8).  

 

Figure 8 Entering device information 

Adding Device Information 

1: On the Device-Zone Setup dialog box, click the Add button. The Insert/Update 
section will become active. 

2: Type the device ID number. 
(This is the Activator ID number.) 

3: Enter a descriptive name for the device’s location. 

4: Click Inside, Muster Site or Outside from the Tag Type drop-down list. 

Inside – this read indicates that the person has logged into the building 

Muster Site – this read indicates the tag is at this location. 

Outside – this read indicates that the person is logged out to the building 

5: Click Update. The information will be displayed in the table. 

6: Continue to add devices or click OK to finish. 
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Editing Device Information 
Only the description and type of a device can be changed. 

1: On the Devices tab of the Device-Zone Setup dialog box, select the device listed in 
the table and click Edit.  The Insert/Update section will become active. 

2: Change the information displayed in the Description and Type boxes. 

3: Click Update. The revised information will appear in the table. 

4: Click OK to finish. 

Deleting a Device 

1: On the Devices tab of the Device-Zone Setup dialog box, select the device and click 
Delete. 

2: You will receive a message box asking, “Delete [Device description]?” or if the device 
has been assigned a zone, you will be asked, “[Device description] has 
Relationships. Drop Relationships?”  

Click Yes to delete the entry or click No to cancel. You will receive a message 
saying, “Delete not confirmed. Delete canceled.” Click OK to cancel the delete. 

3: Click OK to finish. 

Zone Information 
A Zone is the receiver ID or the device that has received the signal from the tag. To 
create a zone, click the Zones tab (Figure 9). 

  

Figure 9 Creating zones 

Adding a Zone 

1: On the Zones tab on the Device-Zone Setup dialog box, click Add. The Insert/Update 
section becomes active.  
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2: Type the zone ID (Receiver ID). 

3: Enter a description of the zone. 

4: Click the Update button. The information will appear in the table. 

5: Click OK to finish. 

Editing a Zone  
Only the zone description may be changed. 

1: On the Zones tab of the Device-Zone Setup dialog box, select the zone to be edited 
and click Edit.  

2: Change the zone description and click Update. The revised information will appear in 
the table. 

3: Click OK to finish. 

Deleting a Zone 

1: On the Zones tab of the Device-Zone Setup dialog box, select the zone and click 
Delete. 

2: One of two messages will be displayed: 

·  “Delete [Zone description]?” 
 

·  “[Zone description] has Relationships. Drop Relationships?”  This message will 
be displayed if If the zone has been assigned a device  

3: Click Yes to delete entry or click No to cancel. 

NOTE  If you select No, a message will display saying, “Delete not confirmed. Delete 
canceled.” Click OK to cancel the deletion of the zone. 

4: Click OK to finish. 

 

Figure 10 Assigning devices to zones. 
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Adding a Device to a Zone 

1: On the Zone Members tab of the Device-Zone Setup dialog box (Figure 10), select 
the zone from the table. A list of devices assigned to that zone will appear in the 
bottom left table, and a list of available devices is displayed in the bottom right table. 

2: Select a device to be added from the Available Devices table on the right. 

3: Click << Add. The device will be listed as a member of the selected zone in the left 
table. 

4: If a device you have selected has been already added to a zone, a message will 
display asking, “[Device ID] is already present in other zones: [Zone ID] Do you still 
want to add [Device ID] to [Zone ID]?” 

Click Yes to add or click No to cancel. 

5: To receive this warning message each time you try to assign a device to multiple 
zones, select the Advise on multiple membership check box. 

6: Click OK to finish. 

Deleting a Device from a Zone 

1: On the Zone Members tab of the Device-Zone Setup dialog box, select the Zone to 
which the device is assigned to in the top table. 

2: Select the device you want to delete from the devices listed in the bottom left table. 

3: Click the Delete button. 

4: Click OK to finish. 

Log Retention Configuration 
You must be logged in as the Administrator to use any of the options in the Configuration 
menu.  

1: From the Configure menu, select Event Retention Days. The Event Log Retention 
Schedule dialog box will appear (Figure 11). 

 

Figure 11 Log configuration 

 

2: Enter the number of days to retain normal event and alarm information in the log in 
the provided boxes. 

3: Click OK to save the perimeters. 
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NOTE  Old records will be automatically purged the next time the database is 
opened. 

Time Span Window Configuration 
1: Select Time Span Window from the Configure menu. The Time Span Window dialog 

box appears (Figure 12). 

 

Figure 12 Time Span Window 

2: The first box determines the time (in seconds) AxcessView waits for Tag information 
from both an asset and personnel.  Enter the time (in seconds) in the box.   

If Tag readings are detected, further apart than the time given, AxcessView gives an 
alarm. (See Assigning an Owner) 

3: The second box sets the amount of time (in seconds) AxcessView waits before 
reporting a Tag still in the field. Enter the time (in seconds) in the box. 

4: Click Close. 

Alarm Configuration 
Each Receiver, when properly wired and configured, can trigger up to two TTL outputs 
upon an alarm event. 

1: From the Configure menu, select Alarm - Data Format. The Alarm-Data Format 
dialog box will appear (Figure 13). 
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Figure 13 Setting up alarms and relays 

2: From the Action drop-down list, select the type of event that should cause an alarm 
condition. 

·  Normal Tag Read – indicates a tag has passed through a RF field and 
broadcasted it identification information to a receiver. 

·  Panic Tag Read – indicates an alarm code has been transmitted from a tag in 
which the panic button on the tag has been depressed. 

·  Tamper Tag Read – indicates a tamper alarm has been transmitted from a tag in 
which tampering or removal has taken place. 

·  Asset Movement Alarm – indicates an asset has been read without the 
authorized owner within the specified time window. 

·  Cabinet Open – indicates a Door Open beacon has been transmitted from a tag 
in which an external sensor detected the opening of the door. 

3: Select ASCII for the Relay Command Type.  

4: Verify that the ASCII command values are the following: 10c for C1 and 11c for C2 
located at the top right.  

5: Select the TTL output, if any, that you want to trigger by selecting Trigger Relay C1 
and/or Trigger Relay C2 check boxes located at the top right. 

6: Select the check boxes by the information you want written to the log file in the Event 
Log Fields. 

·  TagID – tag ID number 

·  FC – Facility Code 
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·  Comment – employee’s name, asset or event information and alarm messages 

·  Location – activator ID and description of the location 

·  Zone – receiver ID and zone description. If a zone has not been assigned, 
“Unknown” will be displayed. 

·  Time – time and date when event occurred 

·  Type – type of tag 

·  Event – a sequential number for each event, including alarm confirmations and 
acknowledgments 

 
7: Add any comments you want to proceed an alarm when written to the log file in the 

User Defined String box. 

8: A WAV file can be selected to play upon an alarm event by clicking Browse and 
locating the desired WAV file. 

IMPORTANT!  You must click Apply before moving to the next alarm type, or the 
settings will not be saved.  

9: Click OK to finish. 

 

����
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Running AxcessView 

Connecting to a Device 
1: From the Connection menu, select Connect Device or click the green Connect button 

on the tool bar: The Device Connection dialog box will appear (Figure 14). 

     Connect button 

NOTE  You must have a database open to connect to a Device.  

 

Figure 14 Connecting to a device.  

2: Select the connection method – Network or RS-232 Cable. The rest of the dialog box 
becomes active according to what connection method you selected. 

3: For a network connection, enter the device’s IP address and port number in 
appropriate boxes. The default port number is 3001. 

4: If you  have a TCPIP network receiver and want to automatically reconnect to this 
device the next time you log in, select the Auto-Reconnect check box.  

5: For an RS-232 connection, enter the following port information: 

COM Port: The port to which the Reader is connected. 

BaudRate: For a Serial Reader, 9600.  This is a factory default an can be changed 
by the user. 

Parity: None 

DataBits: 8 

StopBits: 1 

HandShake: None 
 

6: Click Connect. The connection information appears in the Device Connection List in 
the top left corner of the main AxcessView screen. If Connection List is not selected 
from the View menu, the connection information will not display.  
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NOTE  If you want to connect to multiple devices, repeat Steps 1-5 to add each device.   

Auto Reconnect 
Selecting the Auto Reconnect option in the Device Connection dialog box sets the Device 
Connection to automatically reconnect each time you log on to AxcessView.  This only 
works with TCPIP network receivers. 

Tags Types 
Tags are part of the ActiveTag automatic identification product line. When a tag receives 
a wake-up signal, it broadcasts its identification information to a receiver. This information 
is used to track personnel, vehicle and assets. Tags can be carried by individuals, placed 
on assets or equipment, or mounted in or on vehicles. There are two types of tags in the 
ActiveTag System, Normal and Beacon. 

Normal 
This type of tag remains inactive or “asleep” until it passes an antenna generating a 
specific RF activation field. Passing through this field causes a message to be 
transmitted to the AxcessView system via the LAN (Local Area Network).  Personnel, 
Asset and Panic are examples of Normal tags. 

Beacon 
This type of tag is read in exactly the same manner as normal tags.  In addition, however, 
Beacon tags transmit messages to the AxcessView system at specific intervals, 
regardless of whether they pass through a RF field or not.  Certain information can be 
included in these messages, such as room temperature and low voltage information.   
The Beacon Tags must be identified to AxcessView in order for the correct interpretation 
of the Beacon Tag data.  Temperature, Tamper and Cabinet are examples of Beacon 
tags. 

Configuring Beacon Tags 
1: Select Beacon Settings from the Configure menu.  The Beacon Tag Options 

dialog box displays (Figure 15). 
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Figure 15 Configuring the Beacon Tag Options 

2: Fill in the Beacon Timeout (in numbers of minutes). 

3: In the Timeouts before warning and Timeouts before alarm boxes, select the 
number of times the tag should time out before sending a warning or an alarm. 

4: From the Low battery generates drop-down list, select Warning or Message.  
Choose to either display a pop-up window (Alarm) -- or, have a Warning 
message listed in the Location Description box of the log list when a tag senses 
low voltage. 

5: For room temperature monitoring, fill in the boxes under Temperature.  Set the 
minimum and maximum temperatures you want AxcessView to monitor.  Select 
Fahrenheit or Celsius readings and set the number of alerts before a Warning is 
sent.  Enter the time interval (in minutes) for temperature checks in the Check 
zones every <   > minutes window. 

6: Type the facility code you want the beacon tag to transmit. 

7: Click OK to finish. 

 Reading Tags 
When Tags are read, information associated with the Tag is displayed in the log list. If the 
Tag is not entered into the database, it is labeled as “Unknown”.  

The log list has the following headings: 

Tag ID Facility Code and ID 
number transmitted by 
the Tag. 

Comment/Description Employee’s name or 
asset’s information. 
Alarm messages 
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including temperature. 

Location-Description Activator ID and 
description/location. 

Zone-Description Receiver ID and zone 
description. If a zone 
has not been assigned, 
“Unknown” will be 
displayed. 

Time/Date Time and date when 
event occurred 

Type Type of tag 

Event A sequential number for 
each event, including 
alarm confirmations and 
acknowledgments.  

 

More information about an event can be viewed by double-clicking the line in the log list. 
A window containing details about the event is displayed.  The status of events in the log 
list is designated by color:  

Black  Ordinary reading 

Bold Red Alarm event 

Red Acknowledged alarm 
event 

Blue Operator warning or 
confirmed alarm event 
or unknown tag read 

Snapshots  (currently not supported) 
If a bitmap file has been assigned to an asset or person, it can be displayed below the 
log list. From the View menu, select Stored Image -- or click the Display Stored Image 
button on the tool bar.   

If an MM-100 has been configured to take a snapshot when a Tag is read, the image can 
be displayed by selecting Event Snapshot from the View menu -- or by clicking the 
Display Video Snapshot (camera) button on the tool bar.  

Alarms 
When an alarm condition is detected, AxcessView displays a dialog box showing the 
information about the event (Figure 16).  
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Figure 16 An alarm dialog box 

 

Types of Alarms 
The following alarms can be displayed by AxcessView: 

 

Linked Asset – No Owner Specified: [description] Indicates that an asset was 
detected that did not have an owner assigned through the Asset Management section. 
When this alarm appears, a warning message will state, “Primary Owner of [asset ID] not 
found” 

Beacon Timeout!  The time period for a beacon tag read to expire. 

[Name](Panic) Indicates that a person pressed the panic button on a panic Tag. The 
device ID is reported as “0.” 

Tamper Alarm! Indicates that a Tamper Tag has been removed from an asset. The 
device ID is reported as “0.” 

Warning – UNAUTHORIZED Asset Movement Detected: [description] Indicates that 
a linked asset was read without the authorized owner being read within the specified time 
window. 

Zone Violation! (linked to the Zone Location designation in the asset/personnel record).  
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Click Information to see information about the person or the asset - too hot, too cold, 
cabinet open. The alarm must be confirmed or acknowledged before the alarm dialog 
box will clear. 

Acknowledging Alarms 
Click Acknowledge to return to the log list. The alarm event will remain red. Alarms can 
only be acknowledged once, if the Alarm Confirmation dialog box is brought up again, the 
alarm must be confirmed.  

Low Battery!  The battery level is low and may expire soon. 

Confirming Alarms 
Click Confirm on the Alarm dialog box. The Operator Confirmation dialog box appears 
(Figure 17). 

 

Figure 17 Confirming an alarm 

Type your name, ID, and a comment in the provided fields. Both boxes must be filled for 
the alarm to be confirmed. Color of the text changes from red to blue and a new line is 
added to the log to indicate that the alarm was confirmed. 

If the alarm had been previously acknowledged, double-click the warning in the log list. 
The Aarm dialog box appears. Click Confirm and fill in the appropriate information. 

Action 
The Action button is currently under implementation. 

Locating Personnel 
By using the Locate Person dialog box, you can view the last know location of a person 
as well as the device ID, date and time, and zone. Movement histories are generated 
from this dialog box as well. 

1: From the Locate menu, select Locate Person. The Locate Person dialog box appears 
(Figure 18). The information can be sorted by clicking the column headings. 
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Figure 18 Locating Personnel 

2: Select the name of the person you want to locate. Information about the last Tag 
event appears in the Last Known Location boxes. 

3: A Movement History report can be viewed on a specific person. Double-click or 
select the person from the list and then click Movement History. 

4: The information that appears in the Personnel Movement History can be printed or 
saved. Select either the printer or the folder icon located at the top of the window. 

Locating Assets 
By using the Locate Asset dialog box, you can view the last know location of an asset as 
well as the device ID, date and time, and zone. Movement histories are generated from 
this dialog box as well. 

1: From the Locate menu, select Locate Asset. The Locate Asset dialog box appears. 
This dialog box is structured the same as the Locate Personnel dialog box (Figure 
18). 

2: Select the asset you want to locate. Information about the last Tag event appears in 
the Last Known Location boxes. 

3: A Movement History report may be viewed on a specific Asset. Double-click or select 
the Asset from the list and click Movement History. 

4: The information that appears in the Asset Movement History can be printed or saved. 
Select either the printer or the folder icon located at the top of the window. 

Locating Events 
1: From the Locate menu, select Locate Events. The Locate and View Events dialog 

box appears. 

2: Enter the dates for the event data you want to view in the Event List Criteria section. 

3: Select the type of data you want to view – Non-alarm events, alarm events or all 
events.  

4: Click Refresh List. The table will display the data for the dates specified. 
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5: Click Close to finish. 

Creating Reports 
Five different types of reports can be generated in AxcessView. 

·  Activity report – lists the events occurring during a specified period of time 

·  Asset Alarm Events Report – lists the alarms detected during a specified period of 
time 

·  Assets List – lists all assets and their custodians 

·  Time and Attendance – lists the attendance during a specified period of time  

·  Mustering Information – lists the personnel and/or assets in the building 

 
1: From the menu bar, select Reports and choose the type of report you want to create 

– Activity Report, Asset Alarm Events Report, Assets List, Time and Attendance and 
Mustering Information– from the Reports menu. The Reports dialog box will appear 
(Figure 19).  

 

Figure 19. Creating a report 

2: In the Data Filter section, select a beginning date by using the arrows to move the 
date forward or backward.  

3: Select the ending date of the report by clicking the arrows to move the date forward 
or backward. 

4: Select Print, Print Preview or Print to File. 

5: Click Close to finish.  

Disconnecting from a Device 
1: Select the device from the Connection list in the top left corner. 

2: Click the red Disconnect button on the tool bar or select Disconnect Device from the 
Connection menu. 

 
 
Disconnect button 
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